NetDMR Permittee and
Data Provider Training




Webinar Details

» EPA is using this webinar to present important
information on NetDMR reporting.

» Due to the expected large number of parficipants, we
are muting all lines except for the lines of the EPA
presenter.

» Listeners can use the webinar ‘Question Box' 1o send In
questions or comments.

» We will be monitoring and answering questions as they
come.
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Intfroduction to NetDMR

How to Create CDX Account — Permittee (signature)
How to Request Access — Signatory

Review My Account

How fto Enter DMR Data

How to Import Data

How to View COR



Introduction to NetDMR



What is NetDMR? (formal

answer)

» National Pollutant Discharge Elimination System
(NPDES) permittees required to subbmit Discharge
Monitoring Reports (DMRs) may use NetDMR after
requesting and receiving permission from their
permitting authority.

» After the State or Region has approved the facility’s
request, the NetDMR tool enables permittees to
complete their DMRs via a secure Internet
connection.



What is NetDMR? (Key Point)

» Web-based application that will allow NPDES
permittees to submit DMRs electronically to EPA’s
Integrated Compliance Information System (ICIS)

» Hosted on Cenftral Data Exchange (CDX) servers

» Provides separate customizable “NetDMR
Program Services”



CDX vs NetDMR - What's the

Difference?

Central Data Network Discharge
Exchange Monitoring Report
(CDX) (NetDMR)

: » Agency's system for the
Agency User account creation electronic reporting and

and management tool used management of DMR data
for access several different

EPA systems with a single login » Uses a "Subscriber Agreement

to authenticate and authorize

Uses "Signature Agreement” to users who Sign and Submit
authenticate and authorize DMRs af a permit level
users who ‘certify’ data » User must sign a Subscriber

Agreement for each NPDES ID
they are requesting Signatory
Role for

Signature Agreement need
only be submitted/approved
once per CDX account



NetDMR as a Program Service
within CDX




Creating a new Central Data
Exchange (CDX) Account



» Go to NetDMR -

Create a New CDX Account

website: SEPA:.
hitps://usepa.servic
enowservices.com/ [s]hiciPMR
oecda iciseid=netdm
_homepage A NetOMR maintenance autagescheduled for Jamuary 3-4

2 Launch NeTDMR
» Click on Launch=" m

NetDMR button [ Training Schedule

#3 Password Reset
o d ,(; Maintenance Schedule

Environmental Topics» Laws & Regulations¥ Report a Violation About EPAY

Welcome to NetDMR Support

ﬁ User Guides & Training
Materials

& e

@ ContactList
[ ]

9 Ask a Question



https://usepa.servicenowservices.com/oeca_icis?id=netdmr_homepage

Create a New CDX Account

» Login screen appears

» Click on create a new
account

NetDMR

Metwaork Discharge
Monitoring Repaort

powered by c%

Sign in

o1 create a new account

* = required

UseriID *
Password *

Forgot username?

Forgot password?




Selecting Instance and User Type

» All * fields are required
Create a New Account

> SeleCT S'l'q'l'e Agency or Select State Agency or EPA Region and User Type
EPA Region (OkO |nSTOnce State Agency or EPA Region *
Name) and User Type Select
» Regulatory Agency where User Type
your DMRs are sent v

» Choose your Instance
from the pull-down menu



Select Instance

» Select .your Regulatory Create a New Account
Authority
> FO[’ eXGmple: Select State Agency or EPA Region and User Type
» Virgin Islands — DMRs are |_51‘atEAgenc}' or EPA Region * _| |
sent fo state agency Select... .
» Choose USVI DPNR-
DEP MetDMR: Tennessee Division of Water Resources ™
MetDMR: Texas TCEQ
> PuerTO RICO fOCIllTIeS NetDMR: Training Instance - OK
submit DMRs fo EPA
» Choose EPA Region 2 NeDMR: Utah DWQ

. T : v
Instance | Network Discharge Monitoring Report - System Admin




Select User Type

» Select User Type Create a New Account
> Pel’mlﬁee (SIgI’]CITUI’e) Select State Agency or EPA Region and User Type
> Permlﬂee (nO State Agency or EPA Region *
Sj andad ture ) NetDMR: EPA Region 06 - AR-GM-LA-NM-OK-TX -
» Data Provider luser e - |
SSeet
Regulated Community
Data Provider
. Permittee (no signature)
» Press NEXT to continue Regulators Anthority
Internal User




CDX User Types

Term

Data Provider

Lab,
Conftractor, or
3rd Party

Affiliate

Permittee
(signature)
)

If vou work for
the company
AND will
Sign/Submit
DMRs

Permittee (no
signature)

If vou work for
the company
but will NOT
Sign/Submit
DMRs

Internal User

This is for
State/EPA
Agency
personnel only




Personal Information

» Fill out required information

» All boxes with asterisks *

» For Permittee (signature)

» Ensure First & Last Names
are your legal names
(e.g. Robert, not Bob)

» Click NEXT when done

Create a New Account

Select State Agency or EPA Region and User Type
Personal Information

Title *

Select. L'
First Name =
Middie Initial
Last Name =
Suffix

Select. .. v

Job Title *

16



Create a User ID and Password

Create User ID &
Password

Select State Agency or EPA Region and User Type
Personal Information
Create a User 1D and Password

UserlID = Password *

Choose 3 Security
questions, and
e nTer O N O nswer These questions will be used to reset your password:

Question 1 *

» Case Sensitive Select a question.

Question 2 *

Select a question...

Agree TO The Terms Question 3 *
Gnd Condi‘l'ions Select a question.

%ﬁe to the Terms and Conditions

Click Next

Verify Password *

] show password

Answer1 =

Answer2 =

Answer 3 *



Signatory Accounts

» Additional steps required if requesting the
CDX role of Permittee (signature)

» Required to answer 5 additional questions
for digitally signing documents

AND

» Electronic Signature Agreement (ESA) or
Paper ESA is required




Electronic Signature Agreement 19
(ESA) Setup —Permittee (signature)

Onl

SeleCT 5 secur"'y EEEEEEE ic Signature Setu p
q U eSﬁO nS fI’O m 'l'h e These questions will be used for signing your document electronically:
d rO p_ d OW n | iST uSe:Ie:tna question... o -
Enter an answer somta e
for eOCh queSTion Question 4 * | Answer 4 *
Se'GCTed Q e a:ues jon... v —

[] show answe
Remember your =

answers!



Updating Signatory Questions
(Demo)

» How do | update my (5) Signatory Questions in
CDXze

» hitps://usepa.servicenowservices.com/oecqa ICise

svs kb 1d=b691361/7/10940d182486eb9ce54bcbfa
&id=kb article view&sysparm_ rank=1&sysparm_ts
queryld=cd3660851b160950cb?21a/5%bc4dbcb/a



https://usepa.servicenowservices.com/oeca_icis?sys_kb_id=b69f36171b940d182486eb9ce54bcbfa&id=kb_article_view&sysparm_rank=1&sysparm_tsqueryId=cd3660851b160950cb91a759bc4bcb7a

Organizational Information

» Search for your
organization

Organization Information

> O rg O n IZG TI O n n O m e Search your organization by one or more of the following criteria:
and State are Organization Name -
required

Mailing Address {line 1)

» Other search fields
are optional

» This is the o = -
organization you —
work for (your
employer)

Mailing Address (line 2)

Find



Select Organization

» Click on the Select button to choose your
Organization

Organization Information

Select your organization:

Show 10 W  entries
Action Organization ID
15948

21820
2291

e 23081

Select 23062

Showing 1 to 5 of 5 entries

Organization Name

GULF COAST STORET

GULF BP CATASTROFHE

Gulf Oil (Test)

Gulf Coast Oil

Gulf Coast Oil

Address 1

11110 ROUNDTABLE DRIVE

100 GULF OF MEXICO DRIVE

100 Main

100 Main

100 Main

Address 2

city

ROSE HILL

CORPUS CHRISTIE

Houston

Houston

Houston

State Zip Code
™ 77375
™ 72019
™ 12345
™ 655432
> 75202

Previous n Next



Organization

» Confirm your Organization

Organization Information

Gulf Oil (Test)
100 Main

Dallas, TX 75202
us

Wrong organizaticn information? Back to search results or regusst that we add your crganization.



How to Add Organization

» If you cannot
find your

O rg O n iZO Tio n Part 2: Orgamization Info
lgeneral foods | Search |

Enter crganization or erganization ID

> “Reques’r that Wﬂlmss City  Swate  ZIPCode
Mo data was found matching your criteria.
we add your

. . . Can't find your arganization? Use advanced search or request that we add your organization.
organizatfion




Add Organization — Contfinued

» Fill out the required
information for your
organization

» Click “Submit Request

for Access”

Part 2: Organization Info

Organization Name * | |

Country * [UNITED STATES

Mailing Address * | |

Mailing Address 2 | |

city * | |

State * | -Plezse Selact- v

ZIP/Postal Code * | |

Email * @yahoo.com

Phone Number * | |

Phone Number Ext | |

Fax Number | |

]




Add Organization - Contfinued

Part 2: Organization Info

» Select your B
. R ) Select a Current Organization
OrgOHIZOTlon ® Request to Add an Organization

Shell Offshore, Inc
701 Poydras St

New Orleans, LA, US
70139

» Enter your . I
Email * cathypermitadm@gmail .com
phone number Phone Number * |[214}665-D£]-Dﬂ |

Phone Number Ext | |

Fax Number | |

Wrong organization information? Back to Search Results, Use advanced search or reguest that we add your organization.

Submit Request for Access




Contact Information

Enter required fields.

Click SEND VERIFICATION
CODE.

A green pop-up note will
appear on screen
informing an email was
sent to this email.

You will receive an email
from CDX support with @
Verification Code within

a few minutes.

Contact Information

Phone Number * Extension

Email *

Re-enter Email =

Send Verification Code

A verification code has been sent o %

\/ cathygfsign@gmail.com. Enter the
Regiﬂer m code below and select Continue to
finalize your CDX account setup.




Email Verification

helpdesk@epacdx.net Today at 2:31 PM
To dianacdxns@yahoo.com

You are requesting an account with the EPA Central Data Exchange (CDX). You will be able to add additional Program Services, including the NPDES eReporting Tool (NeT), to
meet any additional obligations that require electronic reporting to EPA.

In order to complete your registration and begin using the system, you will need to confirm your account by entering the following code in the registration form you are

£3a61172-b391-4ded-a162-a45dc76dedcs
above, you may be required to provide additional information. Any additional information will need to be completed before

you are able to access your Program Service. Please do not respond to this message. If you have questions concerning this request, you may contact us by email at
helpdesk@epacdx.net or by calling the CDX Technical Support 5taff through our toll free telephone support on 888-890-1995 between Monday through Friday from 8:00 am
to 6:00 pm EST/ECT. For International callers, the CDX Help Desk can also be reached at (570) 494-5500.

Sinceraly

CDX Help Desk

United States Environmental Protection Agency - Central Data Exchange

Reply Reply to All Forward Maore



Contact Information/

Registration

» After clicking SEND
VERIFICATION CODE @
verification box will Phone Number * Extension
appear

Contact Information

202-564-3249
» Enter Verification

Code Email *
dianacdxns@yahoo.com
» You can COPY &
PASTE code from Re-enter Emall ©
email direcﬂy into dianacdxns@yahoo.com Sep 4 Verification Code
box.

Verification Code =

I 93ab1172-b391-4ded-a162-a45dc7ededcd I

» Click Register —

Register Continue



Organization Registration

Completed

» After clicking on
REGISTER, this pop-up will

completion
Success!
. You have completed core CDX account registration. Click Continue to proceed. Depending
> C | | C |< CO NTI N U E on your NetDMR role, YOU may be asked to Complete Identity Prooﬁng before your role is

activated.




Registration Process

» At this stage, Permittee (no signature)
and Data Providers are finished and now
have access to NetDMR

» Permittee (signature) must confinue with
ldentity Proofing




Permittee (signature) -

Additional Requirements

» Permittee (signature) will need to
continue as additional information is

required
» |dentify Proofing

» Electronic Signature Agreement
(ESA)

» Paper ESA option

» Log into CDX



ldentity Proofing

Identity Proofing

Identity Verification

Enter required fields _ o — .
Wi_l_h Gn OS.I.eriSk Wyuu like to perform electronic ldentity Proofi Cllck On Whl.l.e .I.Ob
for paper option of

Identity Proofing

Electronic Identity Proofing
The following information will be used for identity proofil

Agree Elec.l.ronic Home Mailing Address (line 1) +
Signature Agreement ome Mating Address (ine 2
(ESA)

City = State + Zip/Postal Code =

Select a State

Verify and Sign — T ST

SSN Last 4: + Phone Number

[] show SSN digits

Paper option available

> CliCl( on Whi_l_e _I_Ob for [ | agree to the Electronic Signature Agreement

paper



Approved ESA-

MyCDX

» Thisis the landing
page when logging

CD)& Central Data Exchange

in-l-o Ne-I-DMR Inhﬂxl | My Profile | -Submissinn Histnrv.
Services Manage
Status ~ Program Service Name v Role +
> C“Ckln.g On.your ROI'E &8 NDMR-WY: NetDMR: Wyoming Department of Permittes
hyper“nk W||| '|'C1 ke yOU Environmental Quality (signature)
to the NetDMR
homepage



Failed Identity Proofing/Paper ESA-

MyCDX

If you failed identity
proofing, you will not
e able to access
NetDMR

» Your role will not be
clickable(not a
hyperlink)

You must sign @
paper ESA and
submit with wet
signature to your RA

35

CD)e Central Data Exchange

|§ [nbox] | My Profile | | Submission History | | Payment History | | E-Ei

Services Manage

Status Program Service Name Role

J.;f MDMR-USVI: NetDMR: USVI DPNR-DEP Permittee
(signature)

& NETEPAMSGP: NeT - EPA Multi-Sector General Preparer

Permit for Stormwater Discharges Associated with
Industrial Activity




ldentity Proofing- Paper ESA

» If LexisNexis is unable to verify your identity —
you Must Submit Paper ESA

Identity Verification

We were unable to verify your identity with the provided information. Please print, review, sign, and mail your paper Electronic Signature
Agreement.

¥ ou have selected to perform identity proofing via the paper based option. Please be aware that the paper based option reguires you to mail a wet ink signed version of the
ESA and does take longer to process. You will not be able o access the NetDMR system until this document is received and processed.

Paper ESA

U.S. Environmental Protection Agency ~
Office of Enforcement and Compliance Assurance
NPDES e-Reporting Tool Electronic Signature Agreement

In accepting the electronic signature credential issued by the U.S. Environmental Protection Agency (EPA) to sign electronic
documents submitted to EPA's Central Data Exchange (CDX). and as a representative for:

Electronic Signature Holder Company Information




Reseting CDX password (Demo) 37

» How fo reset password in CDX:

» hitps://usepa.servicenowservices.com/oeca icisesys kb id=15
/7d7dal1b8601d4eaébé942ecacdbcbb2&id=kb article view&sys
parm_rank=3&sysparm_tsqueryld=a3f6ac821b1609250cb?1a/759
bc4bcbé0

» How Do | Use My Mobile Phone To Reset My
Password In CDXe

» hifps://usepa.servicenowservices.com/oeca icisgesys kb id=05
8i361710940d182486eb%ce54bchb38&id=kb article view&syspa
rm rank=1&sysparm tsqueryld=a217e40d1b160950cb91a75%b

c4bcb?]



https://usepa.servicenowservices.com/oeca_icis?sys_kb_id=1577d7da1b8601d4ea6942ecac4bcb52&id=kb_article_view&sysparm_rank=3&sysparm_tsqueryId=a3f6ac891b160950cb91a759bc4bcb60
https://usepa.servicenowservices.com/oeca_icis?sys_kb_id=058f36171b940d182486eb9ce54bcb38&id=kb_article_view&sysparm_rank=1&sysparm_tsqueryId=a217e40d1b160950cb91a759bc4bcb21

Entering NetDMR

» Click onrole fo access
NetDMR landing page

» Click on ‘Continue to
NetDMR’ to continue.

» Will need to continue
by Requesting Access
to specific NPDES ID(s)
within NetDMR.

FAQs | Getting Started | Contact the NetDMR Team

NetDMR

Network Discharge
Monitoring Report

Welcome

to the EPA Region 06 - AR-GM-LA-NM-0K-TX Installation of NetDMR! NetDMR is a web-based application that

ollutant Discharge Elimination System (MPDES) Permittee Users to enter and electronically submit

Report (DMR) data through the Central Data Exchange (CDX) to EPA. All facilities required to provide

DES permit will need to do so electronically using NetDMFR. as of December 21, 2016. If you are
etDMR. please check out the NetDMR Support https://netdmr.zendesk.com/home

Discharge Moni
DMR data as part of
interested in learning mare

Access NetDMR

Continue to NetDMR

» First time users should check to see if your permit is available in NetDMR yet by Checking vour Permit ID
= If you have any questions about NetDMR, please contact Nguyen.helen@epa.gov.

News

+ There are no news items



User Types and

Roles




User’'s Types in CDX

» Permittees
» Permittee (signature)
» Permittee (no signature)

» Data Providers (Contractors and Labs)

» Internal Users (EPA & State Regulatory Authority)



User’'s Roles in NetDMR

» Permit Administrator
» Permittee (signature) OR
» Permittee (no signature)
» Signatory
» MUST be Permittee (signature)
» Edit
» ALL users
» View
» ALL users



How Types and Roles are

related

Term Who Available Definition
NetDMR Roles
. Lab, Allowed to view, enter and import
Data Provider grg”;[fd‘f;”’ O | Edit, View DMRs into NetDMR and edit CORs but
Affliate they cannot sign and submit forms.

Permittee
(signature)

If vou work for
the company
AND will
Sign/Submit
DMRs

Signatory, Permit
Administrator, Edit,
View

A person authorized to sign, view, edit
and submit DMRs for a specific permit.
Will also be able to approve roles for
other users within NetDMR.

Permittee (no

If vou work for
the company

Permit

Can view, enter and upload DMRs

personnel only

signature) but will NOT Administrator, Edit, | info NetDMR, edit CORs, and approve
Sign/Submit View roles for other users within NetDME.
DMREs
This is for

internal User State/EPA Internal A Regulatory Authority staff member
Agency Administrator with a NefDMR account.




Signatory Role
(Permittee (signature) User)

» You will be able to:
» Sign and submit the Subscriber Agreement

» View, edit, import, sign and delete DMRs

» Submit corrected DMRs — generate CORs

» Initiate the repudiation of unauthorized DMRs

Note: ALL Signatory role automatically get Permit Administrator role



Permit Administrator Role

» Manage Access for their NPDES permit(s)
» Permit Administrator
» Edit
» View (DMRs and CORs)
» Approve Regulatory personnel requesting view partial DMRs

» To edit, import, refresh, and delete DMRs
» Request “Signatory” or “Edit” role

» To Sign DMRs
» Request “Signatory” role



Preparing for

NetDMR




First Steps

» Determine who will be your initial Signatory with Permit Administrator
role

» This person should log on first
» Create account, finalize account, request access
» Verify that Regulatory Agency approved

» |dentify others at your facility that would need the Edit, Permit
Administrator, View or Signatory role(s)

» Other users will have to wait to request access after 15 Signatory is
approved



First Permit ID Request

» Initial Signatory request from your facility

» Will have Signatory and Permit Administrator roles
automatically

> Oilhers at your company can apply for one or more
roles

> Sigljnatory, Permit Administrator role, Edit, or View
role

» (After Initial Signatory is approved)

» Permit Administrators can grant access for
Orlwyone with Permit Administrator, Edit or View
roles



NetDMR

Some of the Basics »\ 1 g



Header Opftions

& User:DMENDOZA_TEST, Permittee User

USVI DPNR-DE

Home | My Account | Request Access | Help | Logout

Network Discharge
Monitoring Report

Manage Search Unscheduled DMRs Import DMRs Update NODI Download

Access Requests All DMRs & CORs Unscheduled DMRs Perform Import Check Results Blank DMR Form
Check Results




Home | My Account | Request Access | Help | Logout & User:DMENDOZA_TEST, Permittes User

N et DM R USVI DPNR-DEP

Network Discharge
Monitoring Report

Manage Search Unscheduled DMRs Import DMRs Update NODI Download

Access Requests All DMRs & CORs Unscheduled DMRs Perform Import Check Results Blank DME Form
Check Results

Logins
QSEE& All D\:“ﬁ | J14/18 4:11PM -

Several Options

(depending on your User Type and Roles)



ol

Manage Access Requests

Manage Search Unscheduled DMRs Import DMRs Update NODI View Download
Access Requests All DMRs 8 CORs Unscheduled DMRs Perform Import Check Results Permits Blank DMR. Form
Permits Check Results Users
Users DMR Signing Status

«f Manage Access Requests

Pending Access Requests - External

Permits 1 through 5 of 5

Name % User Name Facili Permit I Reguested Access Rights Reguest Date Approve Deny Comme
netdmr data pru:winetdmrdatap@gmail.cum USDOE-OAK RIDGE ¥12 PLT TNOOO2968 Edit 02/17/09 |:| D
netdmr signatory netdmrsig@gmail.com USDOE-OAK RIDGE ¥12 PLT TNOOO2968 Edit 0z/18/08 |:| D
netdmr signatory netdmrsig@gmail.com USDOE-OAK RIDGE Y12 PLT TNOOOZ968 View 0z2/19/09 |:| D
netdmr signatory role  netdmrsig@gmail.com USDOE-OAK RIDGE ¥12 PLT THNOOO2968 View 02/17/09 D D
permit admin netdmrpa@gmail.com USDOE-OAK RIDGE Y12 PLT TNOOD2968 Signatory 02/17/0% —

Pending Access Requests - Internal

One item found

Name User Name Organization PermitID Permitted Limit Set Monitoring Reguested Approve Deny Com
Feature ID Designator Period End Date Access Rights

b e = ] . —— e o e A ThiNNNOE0 T4 [ ind=4 fno M=rki=l MRAD — —

A e -




¥ NELWOrK LIscnaryge
I'ﬁ'IMomtoring Report

‘ Manage ‘ Search Unscheduled DMRs ‘ Import DMRs ‘ Update NODI ‘ View ‘ Download
Access Requests All DMRs B CORs Unscheduled DMRs Perform Import Check Results Permits Blank DMR. Form
Permits Check Results Users
Users DMR Signing Status
» Permits
» Copy of Records (COR)
»  List of Users
» DMRs to edit, correct or delete
» DMRs Ready to submit

Detailed instructions are contained in the Permittee/
Data Provider User Guide



DMR Search & Status

Q-Search:

All DMRs & CORs

All DMRs & Copies of Record (CORs)

DMRs Ready to Submit Permit ID

Users

Use the following fields to search for DMRs and CORs. Leaving a field blank will instruct NetDMR not to filter on that field.

® Permit ID:

) Facility:

Permitted Feature:

Discharge:

(@ Monitoring Period End

Date (MPED) Range:

() DMR Due Date:

Edited or Submitted
By:

Status:

Scheduled/Unscheduled:

COR Confirmation #:

Only DMRs and CORs for which the monitoring period has begun will be returned. Future DMR forms are not displayed. A maximum of 200 DMRs are

returned.

All ~
[&n v
All v
[
| E| | T8 (mm/ddfyyyy)
Month| bt | Year| w |
[an v |
Ready for Data Entry ~
NetDMR Validation Errors (Hold down CTRL or Mac command key to select/deselect multiple)
MNetDMR Validated
Imported
Signed & Submitted
Submission Errors/Warnings -

Completed with Errors

All v

| Search || Clear All Fields |




How To Search The DMR With o4

DMR Due Datee

DMR Search

From the All DMR’s and Copies of Record (CORs), pick your Permit ID number from the drop down. The Monitoring Period End Date (MPED) Range
and DMR Due Date have Radio buttons. Then select either the MPED range or DMR Due Date, or no dates at all. If data are entered for one option,
and then the user selects the other radio button, the data for the first option should be blanked out.

@® Monitoring Period End :
Date (MPED) Range: [ l _"] [ _8 (mm/dd/yyyy)

) DMR Due Date: Month v | Year v

When MPED Range button selected, then user should add the start and end date of monitoring. For example: User wants to see all the DMRs
started from 01/01/2021 and ended at 12/31/2021.

@® Monitoring Period End
Date (MPED) Range: 01/01/2021 | T |12/31/2021 78 (mm/dd/yyyy)

O DMR Due Date: Month ~ | Year —

When DMR Due Date button selected, then user can select Month and Year. For example: User wants to see all the DMRs due in January of 2021.

O Monitoring Period End
Date (MPED) Range:

| T8 (mm/dd/yyyy)
® DMR Due Date: Month [January  ~ | Year| 2021 v |

Please notice the MPED Range is gray out since DMR Due Date button was selected.
NOTE: Only DMRs and CORs for which the monitoring period has begun will be returned. Future DMR forms are not displayed. Only a maximum of 200 DMRs are returned.



Requesting Access
(For Permit Administrator, Edit, or
View Roles)

Live Demo



Request Access

Home | My Account equest Access elp | Logout & User:VOISIN.EDWARD@EPA. GOV, Permittes User

NetD

Network Discharge
Monitoring Report

Manage Search Unscheduled DMRs Import DMRs Update NODI Download

Access Requests All DMRs & CORs Unscheduled DMRs Perform Import Check Results Blank DMR Form
Check Results

Last 10 Logins

A search: All DMRs & CORs 5/16/17 12:46 PM -

5/16/17 7:09 AM -
All DMRs & Copies of Record (CORs)



Enter Permit ID (Click Update

Manage Search Unscheduled DMRs Import DMRs Update NODI Download

Access Reguests All DMRs & CORs Unscheduled DMRs Perform Import Check Results Blank DMR Form
Check Results

« Request Access to Permits and Associated DMRs

Enter the ID for the permit whose DMRs you would like to access and click the Update button to see the roles that you can request.
Repeat this process for each permit vou would like to request access to. You can make one or more access requests from this page.

Only users with the Permittee (signature) role in CD¥ can request Signatory roles.

Permit ID: V10040495

Facility Name: BLUEBEARDS BEACH CLUE & VILLAS
Role: Select One v

Mote: The Signatory Role will also automatically be given the Permit
Administrator, Edit, and View Roles.

Add Request



Select Role

=i Request Access to Permits and Associated DMRs

Enter the ID for the permit whose DMRs you would like to access and click the Update button to see the roles that vou c:
Repeat this process for each permit you would like to reguest access to. You can make one or more access requests from

Only users with the Permittee {signature) role in CDX can request Signatory roles.

Permit ID: VIOOD40878
Facility Name: THE REEF ASSOCIATES
Role: Edit v
Select One will also automatically be given the Permit
Signatory ew Roles.
WView
Permit Administrator |
R R o L
Role: | Edit v |

Mote: The Signatory Role will also automatically be given the Permit

it, and View Roles.
Add Request




Submit Request

«' Access Requests

A summary of the current access requests is presented below.

Permit ID Facility Name Requested Role Remove Access
Request

VIO040878 THE REEF ASSOCIATES  Edit
%




Confirm Request

« Confirm Access Requests to a Permit and Associated DMRs

The table below contains the access requests that you have entered.

Permit ID Facility Name Requested Role Additional Information

VI00D40878 THE REEF ASSOCIATES Edit MN/A

Confirm Cancel




Approval

» Wait for your Permit Administrator to approve you

«f Request Access to a Permit and Associated DMRs

------------------------------------------------------------------------------------------------------------------
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How to Request a
Signatory Role

E MNetwork Discharge
Monitoring Report




RO or DAR¢ (Signatories Only)

» Are you a Responsible Official (RO) or a Duly Authorized
Representative (DAR)<e

» Responsible Officials are authorized to sign and subbmit DMRs
themselves (in accordance with 40 CFR 122.22)

» Duly Avuthorized Representatives are authorized to sign and submit
DMRs on behalf of a Responsible Official

» When Requesting Access as a Signatory, DARs will need to enter
the Responsible Official Information to complete the Subscriber
Agreement



Signatory Access Role
(Responsible Official)

Live Demo



To get Request Access

Home | My Account elp | Logout @ User:’ , Permittes User

NetD

D Network Discharge
““al Monitoring Report

Manage Search Unscheduled DMRs Import DMRs Update NODI Download
Access Requests All DMRs & CORs Unscheduled DMRs Perform Import Check Results Blank DMR Form K&

o Session Lo
Check Results

Last 10 Logins

QU search: All DMRs & CORs 5/16/17 12:46PM -

5/16/17 7:09 AM
All DMRs & Copies of Record (CORs)

» Click on “Request Access” to type in the permit you want to have
Signatory access to



Insert Permit ID and Role

NetDMR

Network Discharge
Monitoring Report

Type N Manage Search Unscheduled DMRs Import DMRs Update NODI
Permrl’ |D Access Requests All DMRs & CORs Unscheduled DMRs Perform Import Check Results
Check Results
Click
13 ”
Update

st Access to Permits and Associated DMRs

NeX'l', C“Ck Enter the ID for
Repeat this proces

on drop-

down list

e permit whose DMRs you would like to access and click the Update button to see the roles that yvou
r each permit yvou would like to request access to. You can make one or more access requests fro

Only users with the Par ee (signature) role in CDX can request Signatory roles.

Permit ID: VIO0D40878

Click Facility Name: THE REEF ASSOCIATES

“Siganory”\
Role: Signatory v

MNote: The Signatory Role will also automatically be given the Permit

CllCl( “Add Administrator, Edit, and View Roles.
Request” | Add Request



Submit Request

» Make sure you typed in the
correct Permit ID and Role

» If correct, click Submit
«' Access Requests

A summary of the current access reguests is presented below.

Permit ID Facility Name Requested Role Remove Access
Request

VID040878 THE REEF ASSOCIATES  Signatory
=




Select Radio Button for

Responsible Official

7 Additional Information Required

Please provide additional information associated with the Signatory role.

Permit ID Requested Additional Information
Role

nmo000051  Signatory What is your employer's relationship to the facility or facilities?*: ( Select One ¥ )

I have the authority to enter into this Agreement for the Permittes under the applicable standards.

~/ I am authorized by the person below who does have the authority to enter into this Agreement for the Permittee under the
applicable standards.
The following fields are required.

Responsible Official Name: | |

Responsible Official Title: | |

Responsible Official Phone Number: | |

Responsible Official Email Address: | |

| Submit || Cancel |

» Click on employer's relationship to facility
» Click on first radio button if you are the RO



Paper or Electronic Signature

« Confirm Access Requests to a Permit and Associated DMRs

The table below contains the access requests that you have enftered.

Permit ID Requested Additional Information
Role
nmo000051 | Signatory What is your employer's relationship to the facility or facilities?*:

#®' I have the authority to enter into this Agreement for the Permittee under the applicable standards.

I am authorized by the person below who does have the authority to enter into this Agreement for the Permittee under the
applicable standards.
The following fields are required.

Responsible Official Name: | |

Responsible Official Title: | |

Responsible Official Phone Number: | |

Responsible Official Email Address: | |

( | Sign via Paper || Sign Electronically ||1):ancel |
-

> Click either sign electronically or sign via paper



Paper Signature

» A pop-up window with your SA will appear
» Click on print

_ Print I Close I -+ Click on

Print

Agency: EPA Region 06 - AR-GM-LA-NM-OK-TX (Test)

Subscriber Agreement Number: 5/20cc14-929b-4fdb-bbfb-7ff2e060bc37
Generated On: 2017-11-17 14:49:39.0
Account Reference: 16644

NetDMR Subscriber Agreement Instructions Page
This form can be used for permits issuwed by: EP4 Region 06 - AR-GM-LA-NM-OK-TX
h (Test), hereafter referred to as "the Regulatory Authority”. !




Paper ESA

IE)

Total: 2 sheets of paper (4 pages)

Print

R |

Print ‘ Cancel ‘

\\W18H1N-OEIPSO1.a...

Destination - .

| Change...
Pages e Al
eg. 1-5,8,11-13
Copies 1
Layout Portrait ¥
Color Black and white e
Options W Two-sided

4 More settings

Print using system dialog... (Ctrl+Shift+P)

et

Agency: EPA Reglon 06 - AR-GM-LA-NM-OK-TX (Tesi)
Subscriber Ag Number: 520cci4-929b-4fdb-bbfb-7{i2e(60bc 37

Generated On: 2017-11-17 14:49:39.0
Account Reference: 16644

NetDMR Subscriber Agreement Instructions Page
This form can be used for permits issued by: EPA Region 06 - AR-GM-LA-NM-OK-TX
(Test), hereafter referred to as "the Regulatory Authority™.

A. Signatory Authority Information

The Signatory Authority is the individual that intends to sign DMRs and signs this Subscriber
Agreement in Section E.

User Name: dianasigedx(@yahoo.com
Subscriber Name: Diana Mendoza

Organization: CDX TESTI1
Email Address: dianasigedx(@yahoo.com
Phone Number: (202) 564-2349

B. Permit Information

Signing privileges are requested for the following permits:

Permit ID | Facility Name | Facility Address Relutionship | Authorized By

UNKNOWN ‘
BLOOMFIELD, NM 00000 |12l |S‘"

INMODOOOG0  |[UNKNOWN

C. Terms and Conditions

+ PURPOSE: This agreement creates a legally binding obligation for the signer of the
Agreement (the Responsible Official and/or Signatory Authority) to abide by the terms
and conditions for use of the NetDMR System. and memorializes a mutual understanding
that the signer of this agreement is as legally bound, obligated, and responsible by use of
the assigned ¢l ic si as by a hand-written signature.

& &

ACCEPTANCE & EFFECT: Acceptance of this agreement by the Regulatory Authority
shall be evidenced by notice from the Regulatory Authority. provided clectronically, that
this agreement has been approved.

epacd




Paper Signature

» Upon clicking “Sign via Paper” you will
receive a message stating you will have
to go to My Account 1o print paper SA

& User:DMEMDOZA_TEST, Permittee User

USVI DPNR-DEP

Home | My Account | Request Access | Help | Logout

Discharge
] Report

Unscheduled DMRs Import DMRs Update NODI Download

Unscheduled DMRs Perform Import Check Results Blank DMR Form
Check Results

Manage Searc
Access Reqguests All DMRs

You have chosen to sign a hard copy of your Subscriber Agreement. Your
request will be in Pending status until you print and sign the paper

Subscriber Agreement(s), and mail it to your Regulatory Authority for the
request to be processed. To print additional copies, go to My Account.




Paper Signature

& My Account #  Edit Account

User Name:

First Name: Diana

» To print SA, click on printer icon

Last Name:

Organization: TEST
Job Title: boss
Email:

Telephone Mumber:

Type of User: Permittee User

My Permits

Click any underlinad column title to sort the table rows in ascendi
the default sort order applied.

or descending order by the information in that column. If you click View all or View Partial, the table will be

Showing 3 Permits

Permit ID Access Rights Access Status Subsc Responsible Official Email Process Request Date Update Date
VIDD40878 Edit Pending 05/05/18 06:28 PM 0%/05/18 06:28 PM
VIDD40878  Signatory Pending I Qlagcz.}cgv1ch—4hhc.=aD?1—d902ch2f9ha Paper 0%/05/18 06:41 PM  0%/05/18 06:41 PM

VIDO50326 Signatory Pending = 20a84e1c-a600-4145-614F-5e351db12c71 Electronic 08/14/18 04:5% PM  09/02/18 07:49 PM



Paper Signature

» A pop-up window with your SA will appear
» Click on print

_ Print I Close I -+ Click on

Print

Agency: EPA Region 06 - AR-GM-LA-NM-OK-TX (Test)

Subscriber Agreement Number: 5/20cc14-929b-4fdb-bbfb-7ff2e060bc37
Generated On: 2017-11-17 14:49:39.0
Account Reference: 16644

NetDMR Subscriber Agreement Instructions Page
This form can be used for permits issuwed by: EP4 Region 06 - AR-GM-LA-NM-OK-TX
h (Test), hereafter referred to as "the Regulatory Authority”. !




Print
Total: 2 sheets of paper (4 pages)

R |

Print ‘ Cancel ‘

\\W18H1N-OEIPSO1.a...

Destination - .

| Change...
Pages e Al
eg. 1-5,8,11-13
Copies 1
Layout Portrait ¥
Color Black and white e
Options W Two-sided

4 More settings

Print using system dialog... (Ctrl+Shift+P)

et

Agency: EPA Reglon 06 - AR-GM-LA-NM-OK-TX (Tesi)
Subscriber Ag Number: 520cci4-929b-4fdb-bbfb-7{i2e(60bc 37

Generated On: 2017-11-17 14:49:39.0
Account Reference: 16644

NetDMR Subscriber Agreement Instructions Page
This form can be used for permits issued by: EPA Region 06 - AR-GM-LA-NM-OK-TX
(Test), hereafter referred to as "the Regulatory Authority™.

A. Signatory Authority Information

The Signatory Authority is the individual that intends to sign DMRs and signs this Subscriber
Agreement in Section E.

User Name: dianasigedx(@yahoo.com

Subscriber Name: Diana Mendoza
Organization: CDX TESTI

Email Address: dianasigedx(@yahoo.com
Phone Number: (202) 564-2349

B. Permit Information

Signing privileges are requested for the following permits:

Permit ID | Facility Name | Facility Address Relutionship | Authorized By
. , UNKNOWN 3
INMOD00OGD  [UNKNOWN [ " e o M Facility |s:|r

C. Terms and Conditions

+ PURPOSE: This agreement creates a legally binding obligation for the signer of the
Agreement (the Responsible Official and/or Signatory Authority) to abide by the terms
and conditions for use of the NetDMR System. and memorializes a mutual understanding
that the signer of this agreement is as legally bound, obligated, and responsible by use of
the assigned ¢l ic si as by a hand-written signature.

& &

ACCEPTANCE & EFFECT: Acceptance of this agreement by the Regulatory Authority
shall be evidenced by notice from the Regulatory Authority. provided clectronically, that
this agreement has been approved.

epacd




Where to mail Subscriber

Agreement

» Once signed, mail Subscriber Agreement (SA) to
your Regulatory Authority (RA)

» You can find your RA's mailing information on
the bofttom of SA form

Print this form, save a copy for your records, and mail to:
USVI DPNR-DEP

Attn: Mr. Norman D. Williams

45 Mars Hill

TPDES Permitting Program

Frederiksted , VI 00840




Approving/ Denying Paper
Subscriber Agreement

» RA accesses NetDMR to approve/deny
pending Signatory access role

» Note: Paper process can take several
weeks to complete



Electronical Signature

» Upon clicking on “Sign Electronically”, a pop-up box will appear
confirming you have chosen to sign your Subscriber Agreement

electronically
» Asan RO, your request will be sent directly to your RA via email

» Click on Sign Electronically to sign SA

Please sign the Subscriber Agreement(s) by clicking the 'Sign Electronically’ button below.

If you are a Responsible Official, your request will be sent directly to the Regulatory Authority via email. If you are a
i Duly Authorized Representative, your Responsible Official must access NetDMR to approve your request before it is

' sent to the Regulatory Authority.

Your status will be Pending until your request is approved by the Regulatory Authority. Thank you for choosing to sign
i your Subscriber Agreement electronically.

Sign Electronically | Cancel |




Electronical Signature

eSignature Authorization

1. Authenticate 2. Verify 3. Sign
Login to CDX
User: Question:

What is your favorite movie?

Password:
Answer:

» Complete the following steps for authorization:
= Enter password to start authenticate eSignature process.

= Answer security question
= Click on “Sign”



Route 1o RA

» After signing SA, a message will appear
confirming your electronical signature

«f Request Access to a Permit and Associated DMRs

——————————————————————————————————————————————————————————————————————————————————————————————————————————————————

‘/ Signing of the Subscriber Agreement(s) was successful.
Your access request(s) have been submitted for approval.

__________________________________________________________________________________________________________________



Signatory Access Role
(Duly Authorized Representatives)



Prerequisites

» User must be User Type: Permittee (signature).

» DAR MUST first consult with RO to determine if RO will sign
Subscriber Agreement via electronic process or paper
Process.

» If RO will sign electronically, RO will be required to create a
CDX account.

» If RO does not want to create a CDX account, RO must sign
paper Subscriber Agreement, which forces the DAR to submit
paper Subscriber Agreement.

» Signatory must be first person to request access to a Permit
ID.

» Regulatory Authority must approve all Signatory requests.



Signatory Access Role
(Duly Authorized Representatives)

Live Demo



To get Request Access

Home | My Account equest Access elp | Logout @ User:’ , Permittes User

:
D Nﬂ- wo*k D scharge VU[

Monitoring Report

Manage Search Unscheduled DMRs Import DMRs Update NODI Download
Access Requests All DMRs & CORs Unscheduled DMRs Perform Import Check Results Blank DMR Form [l

“ Session Lo
Check Results

Last 10 Logins

QU search: All DMRs & CORs 5/16/17 12:46PM -

5/16/17 7:09 AM
All DMRs & Copies of Record (CORs)

» Click on “Request Access” to type in the permit you want
to have Signatory access to



Insert Permit ID and Role

NetDMR

Network Discharge
Monitoring Report

Type N Manage Search Unscheduled DMRs Import DMRs Update NODI
Permrl’ |D Access Requests All DMRs & CORs Unscheduled DMRs Perform Import Check Results
Check Results
Click
13 ”
Update

st Access to Permits and Associated DMRs

NeX'l', C“Ck Enter the ID for
Repeat this proces

on drop-

down list

e permit whose DMRs you would like to access and click the Update button to see the roles that yvou
r each permit yvou would like to request access to. You can make one or more access requests fro

Only users with the Par ee (signature) role in CDX can request Signatory roles.

Permit ID: VIO0D40878

Click Facility Name: THE REEF ASSOCIATES

“Siganory”\
Role: Signatory v

MNote: The Signatory Role will also automatically be given the Permit

CllCl( “Add Administrator, Edit, and View Roles.
Request” | Add Request



Submit Request

» Make sure you typed in the
correct Permit ID and Role

» If correct, click Submit
«' Access Requests

A summary of the current access reguests is presented below.

Permit ID Facility Name Requested Role Remove Access
Request

VID040878 THE REEF ASSOCIATES  Signatory
=




Enter Responsible Official

InNformation

=l Confirm Access Requests to a Permit and Associated DMRs

The table below contains the access requests that you have entered.

Permit ID Facility Name Requested Additional Information
Role
V10040878 THE REEF Signatory What is your employer's relationship to the facility or facilities?*: ility v
ASSOCIATES i P . !

I have the authority to enter into this Agreement for the Permittes under the applicable standards.

I am authorized by the person below who does have the authority to enter into this Agreement for the Permittee under the
applicable standards.
The following fields are required.

Responsible Official Name: |Jar1e |
Responsible Official Title: |Doe |
Responsible Official Phone Number: |202—555—5555 |
Responsible Official Email Address: |SDMFS@GMAIL.CDM |

Sian via Paper || Sign Electronically || Cancel |

» Click on employer's relationship to facility
» Click on second radio button if you are the DAR
» Make sure to type in your RO's email address correctly



Paper or Electronic Signature

=l Confirm Access Requests to a Permit and Associated DMRs

The table below contains the access requests that you have entered.

Permit ID Facility Name Requested Additional Information
Role
V10040878 THE REEF Signatory What is your employar's relationship to the facility or facilities?™: ility
ASSOCIATES v ploy P ty [Facility v |

I have the authority to enter into this Agreement for the Permittes under the applicable standards.

“ 1 am authorized by the person below who does have the authority to enter into this Agreement for the Permittee under the
applicable standards.

The following fields are required.
Responsible Official Name: |Jane |
Responsible Official Title: |Doe |
Responsible Official Phone Number: |202—555-5555 |
Responsible Official Email Address: |SDMFS@GMAIL.CDM |

Sign via Paper || Sign Electronically || Cancel |

» Click either sign electronically or sign via paper



Paper or

Electronic Signature

» Remember, this determination( to sign via
paper of electronically) is made in
consultation with your RO.

»If RO rec
Sign via

uires paper, DAR must choose
Paper.

»|f RO reo

uires electronic, DAR must choose

Sign Electronically.



Paper Signature

» Upon clicking “Sign via Paper” you will
receive a message stating you will have
to go to My Account 1o print paper SA

& User:DMEMDOZA_TEST, Permittee User

USVI DPNR-DEP

Home | My Account | Request Access | Help | Logout

Discharge
] Report

Unscheduled DMRs Import DMRs Update NODI Download

Unscheduled DMRs Perform Import Check Results Blank DMR Form
Check Results

Manage Searc
Access Reqguests All DMRs

You have chosen to sign a hard copy of your Subscriber Agreement. Your
request will be in Pending status until you print and sign the paper

Subscriber Agreement(s), and mail it to your Regulatory Authority for the
request to be processed. To print additional copies, go to My Account.




Signature

» To print SA, click on printer icon

& My Account " Edit Account

User Name:
First Name: Diana

Last Name:

Organization: TEST
Job Title: boss
Email:

Telephone Number:

Type of User: Permittee User

My Permits

Click any underlined column title to sort the table rows in ascending or descending order by the information in that column. If yvou click view all or View Partial, the table will be
the default sort order applied.

Showing 3 Permits

Permit ID Access Rights Access Status Subscriber Agreement Responsible Official Email Process Request Date Update Date
VIOOD40878 Edit Pending 05/05/18 06:28 PM 0%9/05/18 06:28 PM
VIDO40878 Signatory Pending EQCZSCSc,=12cd—4hb&a0?1-d902f0c2f9ha Paper 0%/05/18 06:41 PM  0%9/05/18 05:41 PM

VIDOS0326 Signatory Pending (D 2o284e1c-260c-4146-814f-5e351db12c71 Electronic 08/14/18 04:5% PM 09/02/18 07:45 PM



Paper Signature

» A pop-up window with your SA will
appear.

» Click on print.

_ Print I Close I -+ Click on

Print

Agency: EPA Region 06 - AR-GM-LA-NM-OK-TX (Test)

Subscriber Agreement Number: 5/20cc14-929b-4fdb-bbfb-7ff2e060bc37
Generated On: 2017-11-17 14:49:39.0
Account Reference: 16644

NetDMR Subscriber Agreement Instructions Page
This form can be used for permits issuwed by: EP4 Region 06 - AR-GM-LA-NM-OK-TX
h (Test), hereafter referred to as "the Regulatory Authority”. !




Final Print

Print
Total: 2 sheets of paper (4 pages)

R |

Print ‘ Cancel ‘

\\W18H1N-OEIPSO1.a...

Destination - .

| Change...
Pages e Al
eg. 1-5,8,11-13
Copies 1
Layout Portrait ¥
Color Black and white e
Options W Two-sided

4 More settings

Print using system dialog... (Ctrl+Shift+P)

et

Agency: EPA Reglon 06 - AR-GM-LA-NM-OK-TX (Tesi)
Subscriber Ag Number: 520cci4-929b-4fdb-bbfb-7{i2e(60bc 37

Generated On: 2017-11-17 14:49:39.0
Account Reference: 16644

NetDMR Subscriber Agreement Instructions Page
This form can be used for permits issued by: EPA Region 06 - AR-GM-LA-NM-OK-TX
(Test), hereafter referred to as "the Regulatory Authority™.

A. Signatory Authority Information

The Signatory Authority is the individual that intends to sign DMRs and signs this Subscriber
Agreement in Section E.

User Name: dianasigedx(@yahoo.com
Subscriber Name: Diana Mendoza

Organization: CDX TESTI1
Email Address: dianasigedx(@yahoo.com
Phone Number: (202) 564-2349

B. Permit Information

Signing privileges are requested for the following permits:

Permit ID | Facility Name | Facility Address Relutionship | Authorized By

UNKNOWN ‘
BLOOMFIELD, NM 00000 |12l |S‘"

INMODOOOG0  |[UNKNOWN

C. Terms and Conditions

+ PURPOSE: This agreement creates a legally binding obligation for the signer of the
Agreement (the Responsible Official and/or Signatory Authority) to abide by the terms
and conditions for use of the NetDMR System. and memorializes a mutual understanding
that the signer of this agreement is as legally bound, obligated, and responsible by use of
the assigned ¢l ic si as by a hand-written signature.

& &

ACCEPTANCE & EFFECT: Acceptance of this agreement by the Regulatory Authority
shall be evidenced by notice from the Regulatory Authority. provided clectronically, that
this agreement has been approved.

epacd




Where to mail SA

» As a Duly Authorized Representative, your Responsible Official
must sign your request before it is sent to the Regulatory
Authority.

» You can find your RA’'s mailing information on the bottom of SA
form.

» Your status will be Pending until your request is approved by the
Regulatory Authority.

Print this form, save a copy for your records, and mail to:
USVI DPNR-DEP

Attn: Mr. Norman D. Williams

45 Mars Hill

TPDES Permitting Program

Frederiksted ., VI 00840




Approving/ Denying Paper
Subscriber Agreement

» RA accesses NetDMR to approve/deny
pending Signatory access role.

» Note: Paper process can take several
weeks to complete.



96

Electronic Subscriber Agreement

» For DAR to submit the Subscriber Agreement
electronically, the Responsible Official (RO) must have a
CDX account and access to the NetDMR Program
Service.

» If RO chooses to submit Paper Subscriber Agreement,
DAR must also sign paper. Paper and Electronic process
cannot be mixed.

» Electronic submission of Subscriber Agreement is much
faster than paper. It can take only a few minutes to
complete



Electronical Signature

» Upon clicking on “Sign Electronically”, a pop-up box will appear
confirming you have chosen to sign your Subscriber Agreement
electronically.

» Click on Sign Electronically to sign SA.

» Note: As a DAR, your RO must have access to NetDMR to approve request
before it is sent to RA.

Please sign the Subscriber Agreement(s) by clicking the 'Sign Electronically' button below.

If you are a Responsible Official, your request will be sent directly to the Regulatory Authority via email. If you are a
: Duly Authorized Representative, your Responsible Official must access NetDMR to approve your request before it is
i sent to the Regulatory Authority.

Your status will be Pending until your request is approved by the Regulatory Authority. Thank you for choosing to sign
+ your Subscriber Agreement electronically.

Sign Electronically \ Cancel '




Electronical Signature

eSignature Authorization

1. Authenticate 2. Verify 3. Sign
Login to CDX
User: Question:

What is your favorite movie?

Password:
Answer:

» Complete the following steps for authorization:
= Enfer password to start authenticate eSignature process.

=  Answer security question
= Click on "Sign”



Route 1o RA

» After signing SA, a message will appear
confirming your electronical signature.

«f Request Access to a Permit and Associated DMRs

——————————————————————————————————————————————————————————————————————————————————————————————————————————————————

‘/ Signing of the Subscriber Agreement(s) was successful.
Your access request(s) have been submitted for approval.

__________________________________________________________________________________________________________________



Initial Request

E‘(‘_ Reply E—;"_ Reply All LC:‘, Forward
Thu 9/6/2018 1:27 PM

N netdmr-notification-test@epacdx.net

Diana Mendoza has initiated a paper process NetDMR Signatory Request for
vour approval (7c¢9b9e1d-721c-4512-bfe3-6c48a7bd5a23)

. u

Cc

Retention Policy Inbox (Mever) Expires Mever

oWe removed extra line breaks from this message,

Diana Mendoza has initiated a paper process requesting the signatory role with access to the
following Permit(s) in NetDMR for EPA Region 06 - AR-GM-LA-NM-0OK-TX (Test):

Permit ID: GMG290001, Permitted Facility Name: SOJITZ ENERGY VENTURE, INC.

For reference, the Subscriber Agreement number for this request is 7c9b9e1d-721c-4512-bfe3-
6cd8a7bd5a23.

Upon receipt of the signed paper copy Subscriber Agreement(s), please log into NetDMR using EPA's
Central Data Exchange (CDX) https://testngn.epacdxnode.net/ceca-netdmr-web/action/login and
access the EPA Region 06 - AR-GM-LA-NM-OK-TX (Test) program service. Click Continue to NetDMR.
Then, under Manage Access, review this request and approve or deny it once you have followed
your organization’s procedures for validating paper NetDMR signatory requests.

Thank you.

This message was sent from the EPA Region 06 - AR-GM-LA-NM-TX Test Environment.



Request Approved

2 Reply @}1 Reply All =} Forward
Thu 9/6/2018 1:18 PM

N netdmr-notification-test@epacdx.net

Masrin Lescure has acted on Signatory Request(s) you submitted in NetDMR
(a9a84elc-ab0c-4148-814f-5e351db12c71)

To

Cc

Retention Policy Inbox (Mever) Expires Mever

oWe removed extra line breaks from this message.

Masrin Lescure has acted on a signatory request(s) with Subscriber Agreement number aSa84elc-
a60c-4148-814f-5e351db12c71 for access to the following Permits in NetDMR for USWI DPNR-DEP:

Permitted Facility Name: GRAPETREE BAY HOTEL Permit 1D: VID050326

Status: Approved
Comment:

For additional information about NetDMR, see https://netdmr.zendesk.com/hc/en-us.

Thank You.



DMR Data Entry




Entering DMRs

» Direct Data Entry

» Import comma delimited file from
spreadsheets

» Edit/Correct DMRs
» Delete DMRs

Detailed instructions are contained in the Permittee/
Data Provider User Guide



Video Demo;

To Stream:
hitps://attendee.gotowebinar.com/recording/
/160705131666025474



https://attendee.gotowebinar.com/recording/7160705131666025474

DMR Errors
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Millian
Season: 0 Req. Reg Mon 30 Regq Man 7 Sallans per Continuous TOTALZ
Day Average Day Average Cay

MDD -
Appwll - voor [=] [ =

‘ Chlarine,
- total - = Iﬁ”‘ =
2 | Jotmor =] [er ]|

SO0&0 residual smpl. — L
|st|
A - Disinfection,
Pracess Cormplete
== dal Micrograms=s
Seaszon: 0O Req. Instantan=sous 9 Craily GRAR
: per Liter
Maxirmum
MODI: I I
HODI I YI
-’-‘mplyl
Edit Check Errors
Code NMame Monitoring Location Field Type Descripton Acknowledge
SO0&0 Chlarine, total Dizinfectian, Process Quality or Concentration Hard Value figlds ray contain numbers and speacial
residual Cormplete Sarmple Walue 2 characters "." , "-", "+" and "," only
Comments

» Indicated on DMR with pink hue and exclamation mark



DMR Errors (Hard, Soft)

Edit Check Errors

Code Name

00400 pH

00400 pH

00310 BOD, S-day, 20
deq, C

00310 BOD, S-day, 20
deg.

00310 BOD, S-day, 20
deq, C

00530 Solids, total
suspended

00530  Salids, total
suzpended

Monitorng
Location

Effluent Gross

Effluent Gross

Effluent Gross

Effluent Gross

Effluent Gross

Effluent Gross

Effluent Gross

Field

Quality or Concentration
Sample Value 1

Quality or Concentration
Sample Value 2

Quality or Concentration
Sample Value 2

Quality or Concentration
Sample Value 3

Excursion

Quality or Concentration
Sample Value 2

Excursion

Type

Hard

Hard

Soft

Soft

Soft

Soft

Soft

Description

A zample value and HODI zeledion cannot be provided for the
same value, Either delete the value(s) or reset the NODI ta
blank.

A zample value and HODI zeledion cannot be provided for the
zarme value, Either delete the value(s) or reset the NCDI to
blank,

The provided sample value is outzide the permit limit,

The provided zample value is outside the permit limit,

The nurnber of excursions should be greater than zero,

The provided zample value is outside the permit limit,

The nurnber of excursions should be greater than zero,

Hard Error — Must be resolved before signing DMR

Acknowledge

= O O 43O 4

Soft Error — Must be ‘Acknowledged’ (or resolved) before signing DMR



Sign DMRs

<« NOTE: Blank DMRs cannot be signed
NetBMR

Manage Search Import DMRs View Download
Access Requests All DMEs & CORs Perform Import Permits Blank DMRE Form
Permits Check Results sers

lsers

qSearch: All DMRs & CORs DMRs Ready to Submit jPermit ID Users

DMRs Ready to Submit

Select an option below to view a list of DMRs ready to sign and submit (i.e., in "MetDMR Validated" st:

All DMRs Search |

GMG290123

Search |

DMRs for Facility [SENECA RESOURCES CORPORATION =] _ Search |

DMRs for Permit ID




Signature DMRs (cont.

# Sign & Submit DMR

Use this page to sign and submit the selected DMR. Confirm your intention to submit by filling the checkbox in the Include in Submission column.
Perform the submission by completing the signature fields at the bottom of the page.

Include in Add Copy of View Permit ID - Facility Permitted Feature Discharge # Discharge Description Monitoring Period End Date DMR Due Date Status
Submission bmissi; Compl d
and DMR
Check All b
Clear All to Email
Motification

Checlk All
Clear aAll
. . VIODD40873 THE REEF ASSOCIATES 001 001-A (no description) 11/20/18 12/28/18 NetDMR Validated

I certify under penalty of law that this submission was prepared under my direction or supervision in accardance with a system designed to assure that qualified personnel
properly gather and evaluate the information submitted. Based on my inguiry of the person or persons who manage the system, or those directly responsible for gathering
the infarmation, the information submitted is, to the best of my knowledge and belief, true, accurate, and complete. I am aware that there are significant penalties for
submitting false infarmation, including the possibility of fine and imprisanment for knowing violations. By entering my password and security question answer and pressing
the Submit button, I agree that:

By entering my password and security question answer and pressing the Submit button, I agree that:

1. I am Diana Mendoza.
2. I have not violated any term in my Electronic Signature Agreement.
3. I am otherwise without any reason to belfeve that the confidentiality of my password has been compromised now or at any time priar to this submission.
4. I have the authority to submit these data on behalf of the listed facilities.
5. This action constitutes an electronic signature equivalent to my written signature.
6. I understand that this attestation of fact pertains to the implementation, oversight, and enforcement of a federal environmental program and must be true to the
best of my knowledge.
Password I J

I Submit || IDD Mot Submit
| NE—



Signature DMRs (cont.

» Entfer security question

7 Sign & Submit DMR

Use this page to sign and submit the selected DMR. Confirm your intention to submit by filling the checkbox in the Include in Submission column.
Perform the submission by completing the signature fields at the bottom of the page.

Include in Add Copy of View Permit ID - Facility Permitted Feature

Discharge # Discharge Description Monitoring Period End Date DMR Due Date Status
Completed
and DMR
Attachments
to Email

Notification

VIOD40873 THE REEF ASSOCIATES 001 001-A (no description) 11/30/18 12/28/18 MetDMR Validated
W W i)

I certify under penalty of [aw that this submission was prepared under my direction or supervision in accordance with a system designed to assure that qualified personnel
properly gather and evaluate the information submitted. Based on my inquiry of the person or persons who manage the system, or those directly responsible for gathering
the information, the information submitted is, to the best of my knowledge and belief, true, accurate, and complete. I am aware that there are significant penalties for

submitting false information, including the possibility of fine and imprisonment for knowing violations. By entering my password and security question answer and pressing
the Submit button, I agree that:

By entering my password and security question answer and pressing the Submit button, I agree that:

I am Diana Mendoza.
. I have not violated any term in my Electronic Signature Agreement,

I am otherwise without any reason to believe that the confidentiality of my password has been compromised now or at any time prior to this submission.
I have the authority to submit these data on behalf of the listed facilities.

This action constitutes an electronic signature equivalent to my written signature.

. I understand that this attestation of fact pertains to the implementation, oversight, and enforcement of a federal environmental program and must be true to the
beast of my knowledge.

RO R

What is your favorite pet’'s name? m

l SuErnrl: ﬁ Mot Submit




Sign DMRs (cont.

Home | My Account | Request Access | Help | Logout & User:DMEMDOZA_TEST, Permittes Usar

N et DM R USVI DPNR-DEP

Network Discharge
Monitoring Report

Manage Search Unscheduled DMRs Import DMRs Update NODI View Download

Access Requests All DMRs & CORs Unscheduled DMRs Perform Import Check Results Permits Blank DMR. Form 1 Lockout Timer: 28
Permits Check Results Users
Users DMR Signing Status

@ View All Copies of Submissions | (=} DMR/COR Search Results Q\ﬁew DMR Signing Status I

i Signing Process Confirmation - CDX Activity ID: _75cac9ba-ff47-4e73-b551-f1d198cd3f61
Your DMRS are undergoing the SIgning Process

Permit ID Facility Permitted Feature Discharge # Discharge Description Monitoring Period End Date DMR Due Date View Copy of Submission

VIDD40878 THE REEF ASSOCIATES 001 001-A (no description) 11/30/18 12/28/18 @

FINNGE N=bRME



Sign DMRs (cont.

Home | My Account | Request Access | Help | Logout & User:DMENDOZA_TEST, Permittes User

N et DM R USVI DPNR-DEP

Network Discharge
Monitoring Report

Manage Search Unscheduled DMRs Import DMRs Update NODI View Download

Access Requests All DMRs & CORs Unscheduled DMRs Perform Import Check Results Permits Blank DMR Form ion Lockout Timer: 29:4
Permits Check Results Users
Users DMR Signing Status

DMR Signing Status

This screen displays signing activity from the last 7 days.

One message found

CDX Activity ID Submission Time Permit ID Facility Permitted Period End Due Date  CDX Document ID Status
Feature
_75cac9ba-ff47-4e73-b551- 02/06/2018 VIDD40878 THE REEF 001 12/28/2018 20cefaf7-d8c8-4b09-3a25- SIGNED_SUCCESSFULLY

fid198cd3fs1 13:47:45 ASSOCIATES 0b3fai11fs801




Downloading

» Copy of Record (COR)

Manage Search Unscheduled DMRs Import DMRs Update NODI View Download
Access Requests All DMRs & CORs Unscheduled DMRs Perform Import Check Results Permits Blank DMR Form
Permits Check Results Users
Users DMR Signing Status

2 New Search | @ Refine Search | # Sign & Submit Checked DMRI | 7 pownload Checked CORs | | Ilpdate NODI

2 DMR/COR Search Results

One item found

Next Step(s) Permit ID Facility Permitted Discharge Discharge Monitoring Scheduled/ DMR Status COR Include in Batch Include in Batch COR Update NODI
Feature # Description Period End Unscheduled Due Received Submit Download Check AllOn Pa
Date Date Date Check AllOn Page Check AllOn Page
Clear All
Clear All | Clear All |
Viiew Copy of Submissions | VIDD40878 THE REEF 001 o01-A (no 11/30/18  Scheduled 12/28/18 Signed &  09/08/18 O
= ASSOCIATES description} Submitted
{s)




Sample of COR

DMR Copy of Record

113

Permir
Permit & VIDD408TE Permites: THE REEF ASSOCIATES Fachllty: THE REEF ASSOCIATES
Major: Mo Permittes Addrass: 500 TEAGUES BAY Facillty Location: 500 TEAGUES BAY
ST. CROIX, W D0a20 ST. CROIX, W1 005X
Pemitied Featura: i} ] DHachargs: oni-A
Extamal Qutal (o gescrption)
Repoir Dames & S13mws
Monitoring Perbod: From 050118 to 1173018 |Dl|ﬁl Due Date: 12zeNe | Stabua: HetDMR Valldated
Consideranons for Form Completion
The samplies for this outfall shall be taken from a paint representative of the stream and pror io mixing wih any other stream. See pesmit for special condlions.
Principal Executive OMcar
Firat MNams: Title: |‘lmpmr|a:
Last Name:
Mo Dara indicator (NODH)
Form HODI: -
Parametsr Monitornng Loostion Sascon ¥ Param. NODI ‘Guanity or Losding Quality or Condantration # 0of Ex. Frequenoy of Analycic Jampia Typa
Code Hame Gualifier 1 Walse 1 Gualfier?  Walue 2 Unis. Gualfisrd  Value1  Gualifer? Valus ? Gualfier 3 Vaioe 3 Units
Sampls
DO0M0 Terpemature, waber dep. contigrade 1-EMuent Gz 0 - Peamnit Aeq. <= IELY WA M4-degC CADT - Weskly GR-GRAB
Valus KOOI C - Mo Dischae
Sampls
D00 pH 1-ETuentGross 0 - Peamnit Aeg. == 7 MINBLIM <= B3 MAXIMUM 12-3U DT - Weskly GR-GRAE
Valus KO - Mo Discharge: - Mo Dischage:
Sampls
SD0S0Fiow, In conduit o thry reafment plant. 1 -EMuent Gross 0 - Permit Aeq. Fimg Mo ANNL ANG <= E2000 MAXIMUS 07 - gald SEES - Continuous R - Recomder (aug)
Valus KOOI - No Discharge - Mo Discharge

Fubmissien Nome

If a parameter row does not contaln any values for the Sample nor EMuent Trading, then none of the following fields will be submitted for that row: Unis, Mumber of Excurslons, Frequency of Analysls, and Sample Type.

Edit Check Errors
Mo emors.
Coimmants

Amachments
Fo atachmers.
Repor Last Saved By

THE REEF ASSOCIATES

Usar: DMENDOZA_TEST

Mame: Dlana Mendoza

E-Mall: mendoza.mana@ena.gov

Date/Time: 2015-09-06 1344 (Time Zone: -04:00)
RepoiT Last Signed By

Usar: DMENDOZA_TEST

Mame: Dlana Mendoza

E-Mall; mendoza.danafepa.gov

DateiMme: 2018-09-06 1344 (Time Zone: -04:00)



DMR Status




Signing Status

There are 4 signing status values:

» SIGNED_SUCCESSFULLY - Signing process completed

» SIGNING_FAILED - Signing process failed

» PROCESSING - In the process of being signed at CDX
» PENDING - In the queue to be sent to CDX for signing

The only values users should expect to see are the first 4:
SIGNED_SUCCESSFULLY, SIGNING_FAILED, PROCESSING, PENDING.



DMR Submission email = COR

Submission Received

»  After DMR signed & submitted, from netdmr-nofification@epacdx.net,

user receives two DMR submission emails

1- First email:

From: <netdmr-nofification-test@epacdx.net>
Date: Tue, Aug 21, 2018 at 10:20 AM
Subject: COR Submission Received for: VIO000019

NetDMR has sent the following 1 DMR(s) to be signed.

CORs have been created for the following DMRs. These DMRs will be forwarded for further processing:

Permitted Facility Name: HOVENSA LLC
Permit ID: VIO000019
Permitted Feature: 001
Discharge: A - Composed of Wastewater from the lagoon systems.
Monitoring Period End Date: 08/31/18
Signing Status: SIGNED SUCCESSFULLY
Comment:
Attachments included in the COR: No


mailto:netdmr-notification-test@epacdx.net
mailto:netdmr-notification-test@epacdx.net

DMR Submission email - DMR(s) Submittal Passed/Warning/Failed

2- Second email DMR(s) Submittal Passed/Warning/Failed

From: <netdmr-notification-
Date: Tue, Aug 21, 2018 at 10:20 AM
Subject: NetDMR DMR(s) Submittal Passed for: VIOO00019

To: netdmrsig@gmail.com

The following signed 1 DMR(s) were submitted to EPA and were successfully processed:

CDX Transaction |ID: _3a3al52b-8456-4f3f-8548-cel 6c422aa/f

User ID: NETDMRSIG

Timestamp:08/21/201809:55:30

Permitted Facility Name: HOVENSA LLC

Permit ID: VIO000019

Permitted Feature: 001

Discharge: A - Composed of Wastewater from the lagoon systems.
Monitoring Period End Date: 08/31/18




Subject: Action Required: Re-

Sign and Submit

» There are 3 scenarios when a Sign and Submit will
“FAILED” and the DMR is not successfully signed
and submitted



Scenario 1

> Additional Data exists in ICIS that is not on the signed NetDMR DMR form. If this was not in place, a user could sign and submit a DMR form and still
receive violations because the user did not know that ICIS was expecting additional DMR data.

> The following email is received and the user is instructed fo edit the DMR again which will pull in the new data from ICIS onto the NetDMR DMR
form.

> When this email is received, the status of the DMR form in NetDMR is set fo “DMR Validation Errors”. When they user edits the form, a web service
callis made and all of the new data from ICIS is pulled onto the NetDMR DMR form. The user will add the new missing DMR values and re-sign and
submit the form.

From: netdmr-nofification@epa.gov

Sent: Tuesday, June 19,2018 2:16 PM

To: xxxxxx@gmail.com

Subject: Action Required: Re-Sign and Submit the Following DMR(s) for: NCXDMROO1

NetDMR has sent the following 1 DMR(s) to be signed.

An error occurred during the signing of the following DMR(s). As a result, your submission was not successfully submitted and a Copy of Record (COR)
was hot created for this fransaction. Please login to NetDMR, select the following DMR(s), and follow the instructions below to re-sign and successfully
submit the DMR(s) as soon as possible:

Permitted Facility Name: FAC SITE

Permit ID: NCXDMROO1

Permitted Feature: 001

Discharge: B - (no description)

Monitoring Period End Date: 01/31/18

Signing Status: FAILED

Comment: Error: The DMR was not successfully signed and submitted. Please login fo NetDMR, search for the failed DMR, edit the DMR, correct the data
issues, click save and re-sign. Once you successfully re-sign and submit your DMR, you should receive two emails from netdmr-nofification@epa.gov
stafing that the DMR was received and submitted successfully.

Aftachments included in the COR: No

CORs have been created for the following DMRs. These DMRs will be forwarded for further processing:


mailto:netdmr-notification@epa.gov
mailto:netdmr-notification@epa.gov

Scenario 2

A system error occurred and CDX or Web Services could not be reached during the signing.

The user is instructed to re-sign the DMR again. When this email is received, the status of the DMR remains at “DMR Validated” and is ready to be
re-signed by the user.

From: netdmr-notification@epa.goc

Sent: Monday, June 18, 2018 2:46 PM

To: darpermittee@gmail.com;

Subject: Action Required: Re-Sign and Submit the Following DMR(s) for: NCXDMROO

NetDMR has sent the following T DMR(s) to be signed.

An error occurred during the signing of the following DMR(s). As a result, your submission was not successfully submitted and a Copy of Record
(COR) was not created for this transaction. Please login to NetDMR, select the following DMR(s), and follow the instructions below to re-sign and
successfully submit the DMR(s) as soon as possible:

Permitted Facility Name: FAC SITE

Permit ID: NCXDMROO1

Permitted Feature: 001

Discharge: A - (no description)

Monitoring Period End Date: 01/31/18

Signing Status: FAILED

Comment: Error: The DMR was not successfully signed and submitted. Please login to NetDMR, search for the failed DMR and re-sign. Once you
successfully re-sign and submit your DMR, you should receive two emails from netdmr-notification@epa.gov stating that the DMR was received
and submitted successfully.

Attachments included in the COR: Yes

18MegaBytesé.zip

CORs have been created for the following DMRs. These DMRs will be forwarded for further processing:


mailto:netdmr-notification@epa.goc
mailto:darpermittee@gmail.com
mailto:netdmr-notification@epa.gov

Scenario 3

A system error occurred where the COR could not be located during a sign and submit:

The user is instructed to re-sign the DMR again. When this email is received, the status of the DMR remains at “DMR Validated” and is ready to be
re-signed by the user.

The user is instructed to re-sign the DMR again. When this email is received, the status of the DMR remains at “DMR Validated” and is ready to be
re-signed by the user.

From: netdmr-notification@epa.gov

Sent: Tuesday, March 13, 2018 11:08 AM

To: darpermittee@gmail.com;

Subject: Action Required: Resign and Submit the Following DMR(s) for: NCSDMROO1

NetDMR has sent the following 1 DMR(s) to be signed.

An error occurred during the signing of the following DMR(s). As a resulf, your submission was not successfully submitted and a Copy of Record
(COR) was not created for this transaction. Please login to NetDMR, select the following DMR(s), and follow the instructions below to re-sign and
successfully submit the DMR(s) as soon as possible:

Permitted Facility Name: FAC SITE

Permit ID: NCSDMROO1

Permitted Feature: 001

Discharge: A - (no description)

Monitoring Period End Date: 06/30/17

Signing Status: FAILED

Comment: Error: Your signature failed. The Copy of Record was not created for this fransaction. Please login to NetDMR, search for the failed DMR
and re-sign. Once you successfully re-sign and submit your DMR, you should receive two emails from netdmr-nofification@epa.gov stating that
the DMR was received and submitted successfully.

Attachments included in the COR: Yes

> CORs have been created for the following DMRs. These DMRs will be forwarded for further processing


mailto:darpermittee@gmail.com
mailto:netdmr-notification@epa.gov

Notice of Non-Receipt for Report Required by your Permit —

Overdue DMRs by 7,14, 21 days

Dear Permittee or Authorized Representative:

We are contacting you to assist you in complying with your NPDES permit reporting
requirements. This is a notification that we have not received a required discharge
monitoring report, but is NOT an official notice of violation.

As of O8/29/7201.8, the following bischarge Monitoring Reports (DMRs) are overdue to lllinois
EPA by 14 days:
- Permitted Feature - Monitoring Period End DMR Due
Facility Name NPDES 1D Designator Date Date
! cImyY ILM580014 | ooz - o7/31/2018 os/is/2018
cITY
! ILM580014 | co3 o7/31/2018 os/is/z2018
cITY
! ILM580014 | ooa o7/31/2018 os/is5/2018
! Iy ILM580014 | ocos o7/31/2018 os/15/z2018
! <Y ILMS80014 | co6 o7/31/2018 os/1s/2018
! Iy ILM580014 | co7 o7/31/2018 os/15/2018
! Iy ILM580014 | ocos o7/31/2018 os/15/2018

Failure to submit your DMR(s) in a timely fashion constitutes non-compliance with the requirements of

yvyour NPDES

pPermit ILM580014. Please be sure to submit all overdue DMRs immediately via NetDMR.

If you have already submitted your DIVMR, please contact us immediately at the email
address belovw so we can help resolve this problem. If you have questions, require
technical assistance or think this information is in error, please

email epa.NetDNMR@Iillinois.gov with your NPDES 1D, your contact information, and
specific information regarding the problem so we can investigate the issue. After you
submit your overdue DMR(s) the system will automatically recognize that you have
done this.

As a reminder, compliance information about your permit is aavailable to the public on
EPA’s ENnforcement Compliance History Online (ECHO) website at https://echo.epa.gov




NODI



No Discharge

» Even if you have no discharge, you will still need to
submit DMR stating there is no discharge with a No Data
Indicator (NODI) or else risk designation of Significant
Noncompliance (SNC) of every quarter until submitted.

» SNC will reflect noncompliance in ECHO until otherwise
corrected.



Active NODI Codes

Operation Shutdown

3 Special Report Attached

7 No Influent

9 Conditional Monitoring — Not Required This Period
A General Permit Exemption

B Below Detection Limit/No Detection

C No Discharge

E Failed to Sample/Required Analysis Not Conducted
F Insufficient Flow for Sampling

| Land Applied

N Not Constructed

P Laboratory Error or Invalid Test (new)

Q Mot Quantifiable

T Environmental Conditions — Monitoring Not Possible (new)
w Dry Lysimeter/Well




Inactive NODI Codes

1 Wrong Flow

4 Discharge to Lagoon/Groundwater
5 Frozen Conditions

3 Other (See Comments)

D Lost Sample/Data Not Available
G Sampling Equipment Failure

H Invalid Test

J Recycled - Water-Closed System
K Natural Disaster

L DMR Received but not Entered
M Laboratory Error

S Fire Conditions

v Weather Related




Update NODI

AlITLR IVEDUILD LW b= L] e ]

DMR Signing Status

A New Search | al Refine Search | - ' Sign & Submit Checked DMRs | Q Download Checked CORs | | ' Update NODI

lesults
Permit ID Facili Permitted Discharge Discharge Monitoring Scheduled DMR Status COR Include in Include in Update NODI
Feature # Description Period End Unscheduled Due Received Batch Submit Batch COR Check All
Date Date Date Check All Download On Page
On Page Check All
On Page
Clear All
Clear All
Clear All
SR0020214 PRASA 001 001-A Treated 09/30/18 Scheduled 10/28/18 Ready for
ADIJUNTAS Wastewaters Data
WWTP Entry
PR0O020214 PRASA 001 001-Q (no 09/30/18 Scheduled 10/28/18 Ready for
ADJUNTAS description) Data
WWTP Entry
°R0O020214 PRASA 001 001-A Treated 08/31/18 Scheduled 09/28/18 Ready for
ADIUNTAS Wastewaters Data v
WWTP Entry



Update NODI

upaatle Nuul

Select New NODI Values

Select a NODI code below or select delete. Click the 'Save & Exit' option above when done.

For a Non-Delete Update NODI transaction, please send an email to netdmr@epa.gov if you do not receive an email
with the subject line NetDMR Import DMR Complete within 24 hours after clicking 'Save & Exit'.

For a Delete Update NODI transaction, please send an email to netdmr@epa.gov if you receive an error message
after clicking "Save & Exit'.

NODI Code: | C - No Discharge v

Delete: [|

Description

Enter a description for the Update NODI transaction. The description will help to identify the transaction when viewing the Update NODI Results.

Description:|No discharge]




Import DMRs




Importing Files

» Import Files allowed for:

» New data
» Partially entered data (in progress)
» DMR Corrections



Roles tor Imporfing

» Signatory
» Import file
» Signh DMR

» Edif
» Import file



Import DMR File Processing

» Two people Importing at the same time or if
you make small revision and submitted a file
2 times.... let the first one finish before
submitting the 279 file

F
NS =
L

4\
C~_T




Video Demo;

» ServiceNow link:
https://usepa.servicenowservices.com/oeca iciseid=
kb _article view&sys kb id=ddfbé08510960950cb?1a/
5%bc4bcbhbb3&spa=1



https://usepa.servicenowservices.com/oeca_icis?id=kb_article_view&sys_kb_id=ddfb60851b960950cb91a759bc4bcb53&spa=1

Resources




Where do | find out more about 135

NetDMR?

2 New ServiceNow URL:

» hifps://usepa.servicenowservices.com/oeca _iCi
seid=netdmr_homepage

= An official website of the United States government.
o United States
Ny’ Environmental
\’ Protection Agency
Environmental Topics'

v Laws & Regulations¥ Report a Violation>

Welcome to NetDMR Support

EN@ERMB

Contact List
-

9 Ask a Question

\



https://usepa.servicenowservices.com/oeca_icis?id=netdmr_homepage

136

Users Support Contact Information:

0 EPA (NPDES eReporting) Helpdesk (recommended)

v Email: NPDESeReporting@epa.gov
v Phone: 1-877-227-8965

v Issues with CDX and NetDMR: Creating account in CDX, changing email
address/Organization only, requesting access to permit (DAR/RQO), submitting
DMRs

O CDX Help Desk
v Email; helpdesk@epacdx.net
v Phone: 888-890-1995

v ONLY If user’'s require name change (first and last)



mailto:NPDESeReporting@epa.gov
mailto:helpdesk@epacdx.net
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